
 Tutorial

Overview of Noise Explorer

Noise Explorer is a program for storing, retrieving and converting measurement data from Brüel & Kjær 

sound level and noise dose meters.

Noise Explorer uses a unique method of presenting the data as a project onto which measurement is 

appended in the form of items on a tree structure. There are many ways of processing the data within 

Noise Explorer, each designed to allow you to present your results in exactly the form you desire.

Measurement data is inserted into Noise Explorer from the instrument via an RS-232 link, via a PC-CARD 

(or other file system), or other Brüel & Kjær sound level meter applications. Once the data is on your hard 

disk, you insert it into a project. A project is a collection of measurement files.

Measurement files are those created by the instruments. They contain the measured parameters of the 

sound source being investigated and, when loaded into a Noise Explorer project, they are read-only. That 

is, once a measurement has been inserted, it cannot be changed.

For users of 2260 Investigator equipped with sound intensity software, Noise Explorer offers the optional 

function of handling measurement files from BZ7205. Information on this can be found in Section 10

General Comments

Noise Explorer uses the Windows graphical interface to the full. This means that to get the best out of 

Noise Explorer and to improve the efficiency with which you use it, you should be familiar with operation 

of Windows programs. In particular, Noise Explorer can display many windows with many different 

parameters on them. You should be proficient with opening, closing and resizing windows.

You should also be aware that most items displayed in Noise Explorer have »hotspots« associated with 

them, meaning that while the mouse cursor is over the item either a small »tooltip« is displayed or 

double-clicking with the left or clicking with the right mouse buttons might bring up new and related 

dialogs and menus. You should feel free to click on items using both mouse buttons to see what happens.

This tutorial cannot cover every part of Noise Explorer. If at any time you are unsure of the function of a 

particular part of Noise Explorer, use the context sensitive help button to get help (or press <F1>). You 

will also notice that many of the dialogs have help buttons on them. Again, use this feature when you are 

in doubt. The Status Bar at the bottom of the Noise Explorer application window often gives you guidance 

about what will happen next or what you should do.

Lastly, Noise Explorer, in common with most Windows applications, often has several ways to achieve the 

same command. There can be a menu item in the main menu bar, a short-cut icon in the toolbar, a 

keyboard short-cut (combinations of the Ctrl, Alt and letter keys), or a direct link from a floating dialog. 

The tutorial introduces you to all of these methods, but be on the look out for short-cuts, etc. as you move 

within Noise Explorer.

Opening a Project



This section shows you how to:

- Open an existing Noise Explorer project

- Rename the project file and the project folder

- Add comments to the project

Note: Noise Explorer has a software key that prevents the program inserting data unless it is present. All 

other Noise Explorer functions are enabled. Because this tutorial is designed to be used even when a 

software key is not present, a dummy project has been created with pre-inserted data. For information 

about inserting data either from instruments or existing data files, see section 9.

Opening an existing Noise Explorer project

When Noise Explorer is first started, a default project is shown. The Project is called Untitled. This is the 

root of a Project tree and is shown as a book. Within this book is a folder called Measurements. There is 

no data in the Project at present. The title bar of Noise Explorer tells you that the current Project database 

is called NXP1.

Click on the  icon on the toolbar. This displays a file-open dialog box. The same operation can be 

done using File/Open Project... Locate the file called demodata.nxp. This is in the B&K7815 

sub-directory of the B&K_APP directory (the default directory for a standard installation). 

Highlight the file called demodata.nxp and click on the Open button.

You have just opened one of the tutorial projects containing pre-inserted measurement files. Notice that 

the title bar now shows the name demodata.NXP. The NXP extension tells Noise Explorer that the file is a 

noise explorer project.



Renaming a Noise Explorer project

Before continuing, rename this project. This is because the source file is read-only, so any changes you 

make cannot be saved in the source file.

Using the Save Project As... command on the File menu, save the new project with a suitable name, for 

example »Tutorial« in the B&K7815 directory.

Now change the name of the root (the Project title) by doing a slow-double click on the name »Untitled«. 

The box surrounding the name enlarges.

Use the keyboard to type in a suitable title, for example »Acme Inc.«. Press Enter when you have 

finished.

The title you have typed in is for your reference and should reflect the particular data you are working 

with. The Project title is not tied to the name of the Project file. This means you can give the project root 

a »real« name, unlike the project file which must have a name consistent with your disk filing system.

Adding comments to a Noise Explorer project

The Project folder ( ) has information about the project attached to it. To see this information, right-click 

on the book icon. A pop-up called Properties appears. Click on this. The document statistics and 

summary pages are shown. 



The information shown is not used in calculations, but is useful for you or your colleagues to see what the 

project is about. 

Enter your name in the Author field. This will tell future users that it is you who have worked on the file.

When you have finished entering the details, click on OK.

Click on  (the Save icon) to save your changes. This saves all the data in your Project to the Project 

file. It is wise to save your work regularly to avoid data loss.

Data Management

This section shows you how to:

- Select specific data

- Add new data to a project

- Look at measurement data in detail

Selecting specific data

In the Measurements branch, locate the Logged file ( ) that is attached to the Type 2236 instrument. 

This logged file contains some dummy data that has been provided for the purposes of this tutorial and is 

designed to imitate measurements made with a Type 2236 SLM within the fictitious Acme Inc. factory. In 

normal use, you would Insert your data into the Measurements branch by transferring it from an 

instrument or another Brüel & Kjær application. See the last section of this tutorial for more information on 

data transfer.



Double click on the logged file. You will see a new window appear - a graph and a set of results. 

Maximize them in the normal Windows way.

Turn your attention to the profile graph (at the top of the set of 2 windows). You will see a number of 

curves (LAeq, LAFmax and LLPeak). Each curve represents a set of measured parameters. The x-axis 

represents time, the y-axis is level.

You can see that the curves are split into five distinct noise profiles with straight lines between them. The 

noise profiles represent recorded noise from each of the machines in the Acme Inc. factory. The straight 

lines represent pauses in the measurement when the operator moved from one machine to another.

Identify the first noise profile. Depending upon the size of your monitor screen, the graph is likely to look 

cramped. The first thing to do is to zoom in on the data you want.

Firstly, click on the  icon to remove the results display, then maximise the graph.

Now, with the mouse cursor, click in the middle of the first pause (time=08:23:00, as displayed by the 

cursor readout region at the bottom of the graph), and, holding the left mouse button down, drag the 

cursor to the start of the profile (time=08:17:33). This process is called click-and-drag.

You will see the selected data becomes highlighted. When you release the mouse button a pop-up menu 

appears. From this popup you can either choose to adjust the time period of your selection or Zoom 

Range. Choose the zoom option.

An expanded view of the noise profile is shown on the screen.

You can zoom back to view the whole graph by right-clicking over the graph and selecting Unzoom.

To zoom out by a factor of two, select Zoom Out from the pop-up menu. To zoom in further by a factor of 

two, select Zoom In from the pop-up menu

Adjusting the Zoom Range Exactly

Using the click-and-drag method to highlight an area of a graph to view allows you to zoom in 

approximately. If you want to zoom in to a precisely defined time axis, you should use the Adjust 

selection option.

Right-click over the graph and select Unzoom. The whole data is displayed again.

Click-and-drag anywhere on the graph to highlight a "random" area. When the pop-up menu appears, 

choose the Adjust selection... option.

The selection window appears.



Adjust the selection so that it is as shown above. (That is, a two minute interval from 08:18 to 08:20). 

Press OK.

You will see a pop-up menu appear. From this popup you can either choose to adjust the time period of 

your selection or Zoom Range. Choose the zoom option.

The graph now displays exactly the range that you have specified.

Adding New Data to the Project

The demodata.nxp project that you opened at the start of the tutorial only contains data from one 

instrument. To add new data to the project, it must be imported. This section shows you how to import a 

measurement file from a 2260 Investigator.

Click on the Import new data from PC-CARD icon ( ).

A standard Windows file selection dialog appears. You will see that there are no files to choose from, 

since the Files of type field is set to Sound Analysis Files (*.s1*). The data we want to import is in s3 

format. (The s3 format is one of the many sound level analyzer file formats produced by Brüel & Kjær 

instruments).

Use the drop-down list to select Sound Analysis Files (*.s3*).

You will now see a file called demodata.s3d appear.

Highlight this and press Open. 

You can see a new set of files automatically appended to the measurements branch. The 2260 icon has 

two measurement files attached to it, a set of history results ( ) and an overall records file ( ).

By clicking on these you will see the information contained within these files. Note that the overall records 

file ( ) does not contain logged information, so there is no profile display available.



Looking at data in detail

This section describes the relationship between the cursor placement on the various displays.

Make sure that you have the demodata.s3d file appended to the Project tree (see section above for 

details).

Select Window/Close All from the main menu to clear the workspace.

Click on the history results ( ) file associated with demodata.s3d.

Toggle the display icons so that they appear like this:

The project tree should disappear, and there should be four panels in the workspace; profile, spectrum, 

text and statistics.

Resize the panels so that they appear similar to those shown below. (to do this, move the mouse cursor 

to one of the joins between the panel and its neighbour. The cursor changes to a  and can now be 

used to drag the panel’s edge to change its width.)

Now place the mouse cursor in the Profile display (top graph), and click somewhere around 14:21:00. 

The red graph-cursor should jump to the closest sample boundary to this time.

Now, using the right-arrow key on the keyboard, move the cursor to the right. Notice how the text and 

spectrum displays change. Take particular notice of the text banner underneath each graphical display 

that shows you exactly the current values at the cursor position.

When the cursor enters the event area (the part marked with a green bar overhead), you can see a lot 

more information suddenly displayed in the spectrum graph and that there are statistics.



What you are doing is moving through the measurement file in time. The spectrum display shows the 

frequency values at that time, and the statistics display shows the statistics for the frequency at which the 

spectrum cursor is placed.

Set the profile display cursor to the interval 14:22:30 - 14:22:33. Click anywhere on the spectrum display.

By using the arrow keys you can now move in the frequency domain at a fixed point in time. Notice how 

the profile display remains static, but the statistics display follows the spectrum cursor.

When the mouse cursor focus is on the statistics display, the display cursor shows the statistics 

information for the selected dB level.

Exporting and Printing Data

This section shows you how to:

- Export data to a spreadsheet

- Print data from measurement files

Export

When you right-click on a display in the workspace a pop-up menu appears. One of the items on this 

menu is the Export to spreadsheet... option.

With this option you can create a new file in either tab separated ASCII (.txt) or Microsoft Excel (.xls) 

format. The file contains the visible measurement data.

For example, if you have zoomed in on a profile graph, selecting the Export to spreadsheet... option 

creates a character-based file using the data that you can see. 

You should note that in the case of the text window, you may have selected (using the right-mouse 

properties pop-up) more parameters to display than can be shown on the screen. By using the scroll bars 

you can see all of the data. The Export function creates a file for all of the data within the scrollable 

window.

When you select the Export option, a standard Windows file save dialog is displayed. Use this to navigate 

to the directory where you want your exported file to be saved. Remember to specify which file format you 

want to use before saving using the Save as type field. ( Choose either tab separated ASCII (.txt) or 

Microsoft Excel (.xls) format using the Save as type field.)

Print

Noise Explorer has a powerful print function that allows you to print to a Windows system printer the data 

from measurement files. 

The print function is invoked using the  icon.

In the Select print items field, set a tick by the items you want printed out. Depending on where you 

have focus, Noise Explorer will suggest which items will be printed.

For example:



- with focus on a display in the workspace, Noise Explorer suggests to print the display and the instrument 

properties associated with it. The other printable items available are those within the same measurement 

file. If selected, they will be printed using the last saved axis scaling.

- with focus on a item in the project tree, Noise Explorer suggests that all the data associated with the 

item/node - including sub-folders and files - are printed. The selected items will be printed using the last 

saved axis scaling.

Highlighting the project folder, , selects all the data.

Pressing the Print button sends the selected items to the printer, or to an .rtf file depending upon the 

Output option selected.

Page Layout

The page layout function allows you to decide how a printed page is laid out. It is accessed from the 

File/Page Setup... menu function.

In the Logo section you can specify a graphics file in the .Filename (*.WMF): field. The filename you 

specify in this field is the windows metafile graphic that will be used to create a logo on the final printed 

paper. Typically your company logo, saved in metafile format, would be your choice. If you do not know 

exactly where the file is stored, use the Locate... button to find it.

The Position from left, Width and Position from top fields allow you to place the top left corner of the 

logo relative to the top left corner of the page.

The Print Logo box should be active if you want the logo to be printed.

If you want to print a page number, activate the Print page number in lower right corner box.

Print Preview

When you select Print Preview ( ), the Print Selection window appears. Select which items you want to 

print, then press the Print Preview button.

Use print preview to see exactly how your selection is going to be printed. For closer inspection of the 

details use the zoom in button.

For printouts that have more than one page, use the Two Page button to see how the pages will look if 

presented in book form. Prev Page and Next Page move you backward or forward through the printing 

stack.

You can print directly from the print preview window by pressing the Print... button.

To exit from Print Preview, use the Close button

About Markers

In this section you can read about the use of data Markers.



Markers are annotations to logged/history graphs that are entered by the operator and/or instrument at 

the time of measurement to exclude/mark data.

Select Window/Close All from the main menu to clear the workspace.

Double-click on the history icon ( ) associated with the demodata.s3d node. Some display windows 

appear.

Make sure the  icon is active so that you can see the profile display and toggle the ,  and  

icons to give maximum space to the profile graph.

You will see that the top of the graph shows a coloured bar showing where the marker is placed, and a 

key to explain what the marker is. In this case it is an event marker.

An event marker is a marker inserted automatically by a 2260 Investigator when running in event logging 

mode. Event markers cannot be changed with Noise Explorer, only viewed.

To view/edit the Marker Properties, double click on the marker or marker label. The Properties window 

has a help button which give you more detail about the way Markers are handled.

Notes about events:

Event logging mode allows 2260 Investigator to measure background sound levels using one set of 

parameters and, when triggered by an event, use another set for the duration of the event.

For example, you might set an event trigger to occur when the LAeq exceeds 70dBA. As long as the 

noise level being monitored was below this value, 1 minute sampling would be in operation. As soon as 

the level goes above this (for example a compressor starts), the sampling rate is reduced to 1 second 

intervals and continues until the level drops below this. You then have a higher resolution account of the 

noise levels during the event.

The events can clearly be seen on the profile display. Firstly they are highlighted by an event marker, and 

secondly the number of measured parameters and logging frequency increases.

In the example the normal logging frequency is set to be one LAeq sample every six seconds. When an 

event occurs, the sampling frequency is increased to once every three seconds.

The Displays in Noise Explorer

This section describes in more detail the parts of the different displays that appear in Noise Explorer. All 

references are to the demonstration data (demodata) supplied with Noise Explorer).

You will read about:

- Profile views

- Text views

 -Statistics views

- Spectrum views

Profile Views



Select Window/Close All from the main menu to clear the workspace.

Open the demodata.s3d item in the Measurements section by either double clicking on the icon or 

selecting Open from the right-click pop-up menu. A window appears in the graphical workspace. 

Maximize it.

At the top of the window is a profile graph. At the bottom a text summary of the measurement data at 

the graph cursor.

At the bottom of the graph are boxes, one for each curve on the graph. Click on these boxes or the 

associated text to draw or hide the respective graph. If you click on a grayed-out box that has no attribute 

associated with it, the History properties window is shown.

Just above these boxes is a line of text telling you the data values at the graph cursor. The graph cursor 

is the vertical red line. Move the graph cursor either by clicking on the graph (the graph cursor jumps to 

the mouse cursor position), or by using the keyboard left- and right-arrow keys. Notice how the summary 

information changes as the graph cursor moves.

The x- and y-axis range of the graph are changed by the Axis section of the Properties window. Access 

the Properties window either via the right-click pop-up menu or double clicking on the graph. Use the Help 

button in the Axis section to get details of how the values affect the graph.

You will also see Legend and Markers tabs in the Properties window. The Legend tab determines which 

of the available measured parameters is associated with a curve on the graph. The Markers tab lets you 

view the properties of any markers set in your project. You cannot change markers in Noise Explorer.

You will also notice Zoom commands on the right-click pop-up menu. The zoom commands have the 

same effect as scaling the x-axis. Unzoom is a special case where the full data range is shown.

You can copy the graph to the Windows clipboard by using the Copy command on the Edit menu, by 

pressing Ctrl+C or by clicking on the copy icon: 

By using the Export to spreadsheet... function located on the right mouse-button pop-up menu, you can 

create a file in either tab separated ASCII (.txt) or Microsoft Excel (.xls) format. The file contains the 

visible measurement data.

Note: To be sure that the graph is copied to the clipboard and not the text, click anywhere within the 

graph area to bring it to »focus« before using the copy command.



The measurement summary and instrument setup data can also be copied to the clipboard in the same 

way. Remember to ensure the text is in focus first.

The print command prints the data you have selected using the print selection dialog. You can see what 

will be printed by using the Print Preview command on the File menu, or by clicking on the Print Preview 

icon: 

Text Views

You can copy the text to the Windows clipboard by using the Copy command on the Edit menu, by 

pressing Ctrl+C or by clicking on the copy icon: 

By using the Export to spreadsheet... function located on the right mouse-button pop-up menu, you can 

create a file in either tab separated ASCII (.txt) or Microsoft Excel (.xls) format. The file contains the 

selected measurement data.

Note: To be sure that the text is copied to the clipboard and not graph or statistics view, click anywhere 

within the text area to bring it to »focus« before using the copy command.

The print command prints the data you have selected using the print selection dialog. You can see what 

will be printed by using the Print Preview command on the File menu, or by clicking on the Print Preview 

icon: 

You should note that in the case of the text window, you may have selected (using the right-mouse 

properties pop-up) more parameters to display than can be shown on the screen. By using the scroll bars 

you can see all of the data. The Export function creates a file for all of the data within the scrollable 

window.

Sometimes the text in the columns is too long to fit in the column width. To resize a column, move the 

mouse cursor to one of the joins between the column heading and its neighbour. The cursor changes to a 

 and can now be used to drag the column edge to change its width.

Statistics Views



At the bottom of distribution graphs are two boxes, one for each curve on the graph. Click on these boxes 

or the associated text to draw or hide the respective graph.

Just above these boxes is a line of text telling you the data values at the graph cursor. The graph cursor 

is the vertical red line. Move the graph cursor either by clicking on the graph (the graph cursor jumps to 

the mouse cursor position), or by using the keyboard left- and right-arrow keys.

At the side of the graph is a list of the fractile values. These are specified in the Ln section of the 

properties window associated with the graph. Access the properties window either by double clicking 

anywhere on the graph or right-clicking anywhere on the graph and selecting Properties from the pop-up 

menu. You can change the fractile values and see the effect in the window after clicking on OK.

The x- and y-axis range of the graph are changed by the Axis section of the properties window. Use the 

Help button in the Axis section to get details of how the values affect the graph.

You will also notice a Zoom command on the right-click pop-up menu. Zooming in and zooming out have 

the same effect as scaling the x-axis. Unzoom is a rescale to full range.

You can copy the graph to the Windows clipboard by using the Copy command on the Edit menu, by 

pressing Ctrl+C or by clicking on the copy icon: 

The print command prints the data you have selected using the print selection dialog. You can see what 

will be printed by using the Print Preview command on the File menu, or by clicking on the Print Preview 

icon: 

By using the Export to spreadsheet... function located on the right mouse-button pop-up menu, you can 

create a file in either tab separated ASCII (.txt) or Microsoft Excel (.xls) format. The file contains the 

visible measurement data.

Spectrum Views



At the bottom of spectrum graph are four boxes, one for each curve on the graph/bar. Click on these 

boxes or the associated text to draw or hide the respective graph/bars.

Just above these boxes is a line of text telling you the data values at the graph cursor. The graph cursor 

is the vertical red line. Move the graph cursor either by clicking on the graph (the graph cursor jumps to 

the mouse cursor position), or by using the keyboard left- and right-arrow keys.

Access the properties window either by double clicking anywhere on the graph or right-clicking anywhere 

on the graph and selecting Properties from the pop-up menu.

The y-axis range of the graph is changed by the Axis section of the properties window. Use the Help 

button in the Axis section to get details of how the values affect the graph.

You will also notice a Zoom command on the right-click pop-up menu. Zooming in and zooming out have 

the same effect as scaling the x-axis. Unzoom is a rescale to full range.

You can copy the graph to the Windows clipboard by using the Copy command on the Edit menu, by 

pressing Ctrl+C or by clicking on the copy icon: 

By using the Export to spreadsheet... function located on the right mouse-button pop-up menu, you can 

create a file in either tab separated ASCII (.txt) or Microsoft Excel (.xls) format. The file contains the 

selected measurement data.

Folder and Tree Management

This section describes methods of improving management of Noise Explorer Projects. In it you can read 

about:

- Tree Management

- Opening and rearranging windows

- Deleting

Tree Management

To avoid confusion and to make using Noise Explorer more efficient, it is a good idea to rename most of 

the items in the tree to avoid having too many unidentifiable »untitled«, »logged«, etc., files.



When you have a project with a lot of branches and attached folders, etc., it can be difficult to focus on 

exactly which sheet or branch you are working with. By clicking instrument icons, you can expand or 

collapse branches to reveal or hide more detail in the tree. A branch that can be expanded has a small + 

sign appended to it. Those that can be collapsed have a - sign.

Opening and Rearranging Windows

Noise Explorer is able to display many different windows within the application area at once. This means 

that a lot of information is presented all at once. In order to focus exactly on the information you want to 

see in several different windows, you can open, close, resize and rearrange them.

Firstly, ensure that the whole Project tree is displayed. This means that no + signs should be visible on 

any branch. If there are, click on the + sign to expand the branch.

Now double click on all the folders at the end of the branches. Each time you do this, a new window is 

opened in the graphical display area. You can also display these windows by right clicking on the tree 

item and selecting Open.

To bring a window to the top of the stack, double click on its tree icon. Alternatively, use the list at the 

bottom of the Window menu to focus on one of the currently opened windows.

The Window menu also offers three items called Cascade, Tile Vertically and Tile Horizontally which 

display all of the open windows in such a way that at least one part of each is visible.

You can also »scroll« forwards through the stack by pressing Ctrl+F6, or backwards using Ctrl+Shift+F6.

You can make more space for viewing graphs and text by changing the width of the Project tree display. 

Do this by moving the mouse cursor to the right boundary of the area. When the cursor changes to two 

vertical lines, hold the left-mouse button down and move the boundary left or right to increase or decrease 

the width. You can also toggle the tree display on and off using the Project View command in the View 

menu or the  icon

Deleting

Folders and Items

Sometimes you may create folders and items by mistake. You can easily remove an item by right-clicking 

on the item and selecting Delete. You will always be asked to confirm deletion before it occurs. There is 

however no undelete function. Once an item is deleted, it is removed from the Project database.

Inserting Data

This section will show you how to:

A - Insert data files produced by an Instrument via RS-232 link

B - Insert data files produced by an Instrument via a PC-CARD or other file system

C - Insert data files produced by other Brüel & Kjær Applications

A. Inserting data files produced by Instruments via an RS-232 link



Note: This section is only relevant if you have a software key and an Instrument. Go to section B if you 

have do not have both of these.

This section shows you how to:

- Insert data files produced by an Instrument

- View the instrument set-up information at the time of recording

- Print or copy the set-up information for reporting purposes

When using Noise Explorer, you can insert measurement files from Instruments via an RS 232C link.

The inserted data is read-only and therefore is never changed.

To insert data files, click on the  icon. This starts the insert wizard.

After selecting the instrument you are going to transfer data from, click on next and follow the instructions 

on the wizard’s pages. If you need further help, click on the Help button.

Viewing set-up information

To view an instrument’s setup information, right click on its icon in the measurements branch of the 

project tree. Select Properties and then choose View/Edit... . A new set of dialogs appears.

Click between the different tabs to see the information about the instrument, its setup and time of 

measurement, etc. You can add your own comments in the Location, Operator, Site Name and 

Keywords fields if you wish. The remaining fields are read only information and cannot be altered.

Printing or copying the set-up information for reporting purposes

By choosing Print... from the Properties pop-up on the instrument icon, you can print out the instrument 

summary information. If you choose Copy, the information is sent to the Windows clipboard ready for 

pasting in as text to other applications.

B. Inserting data files produced by Instruments via a PC-CARD or other file 
system

Note: This section is only relevant if you have a software key. Go to section C if you have do not have 

one.

This section shows you how to:

- Insert data files that are stored in files

- View the instrument set-up information at the time of recording

- Print or copy the set-up information for reporting purposes



When using Noise Explorer, you can insert measurement files from Instruments via a PC-CARD or other 

file system, for example a network server.

You may find it useful to back all your data up on a server for archive purposes. Use the insert via 

PC-CARD option to load these files into a Noise Explorer project.

The inserted data is read-only and therefore is never changed.

To insert data files, click on the  icon. This displays a standard file-open dialog

After selecting the file you are going to import data from, click on the Open button. The selected file is 

appended to the measurements section of the project tree.

C. Importing files from other Brüel & Kjær application programs

This section shows you how to import data files produced by other Brüel & Kjær application programs.

When using Noise Explorer, you can import measurement files from other Brüel & Kjær applications. The 

files would normally be on your local hard-disk or on a network drive.

To import data files, choose Data from other Brüel & Kjær applications... on the Insert menu. This 

starts the import wizard.

After selecting the application you are going to import data from, click on next and follow the instructions 

on the wizard’s pages. If you need further help, click on the Help button.

You can use the Properties pop-up menu to view, copy or print the properties of the imported data for the 

instrument used.

BZ7208 FFT Measurements

Noise Explorer allows you to document FFT measurements made with 2260 Investigator and FFT 

Software BZ7208 - Type 2260H. This is achieved by downloading the measurements into a PC for further 

analysis.

Adding data to a Project

To add data to a new project click with the right-hand mouse button over the measurements folder in the 

default project. This action will open a pop-up menu with different options for importing data.

Highlight the option New Measurement (via PC-CARD)... by keeping the right-hand mouse button 

depressed with the cursor over the item you require. An Open 2260 file, pop-up dialogue box will appear. 

Select Files of type equal to FFT Files (*.stp) at the bottom of the dialogue box. Click on the file shown (

Demodata.FFT).  

The FFT data can be displayed by the Profile View (if the measurement is a logged measurement), the 

Text View and the Spectrum View as described in the previous section The Displays in Noise Explorer.

A Scaling tab has been added to the Axis, Legend and Markers tabs in the Properties window. The 

scaling tab allows you to specify the Y-axis scaling, annotation and unit of FFT data. The settings are 



common to the Profile, Spectrum and Text views of FFT data.

BZ7205 Intensity Measurements

This tutorial assumes that the reader already possesses a basic knowledge of sound intensity, what it is, 

and how it is measured, and has also read the general Noise Explorer Tutorial. 

The sound intensity module in Noise Explorer allows you to document sound intensity measurements 

made with the Hand-held Sound Intensity System, consisting of:

2260 Investigator and Intensity Software BZ7205 - Type 2260E, and Sound Intensity Probe Kit for 2260 - 

Type 3595. This is achieved by downloading the measurements into a PC for further analysis.

Adding data to a Project

To add data to a new project click with the right-hand mouse button over the measurements folder in the 

default project. This action will open a pop-up menu with different options for importing data.

Highlight the option New Measurement (via PC-CARD)... by keeping the right-hand mouse button 

depressed with the cursor over the item you require. An Open 2260 file, pop-up dialogue box will appear. 

Select Files of type equal to Sound Intensity Files (*.stp) at the bottom of the dialogue box. Click on the 

file shown (Demodata.stp). The .stp extension on the file tells Noise Explorer that it is a sound intensity 

file from BZ7205.

The directory tree has a node A hanging underneath the Demodata.stp node. This is because for 

demonstration purposes we have loaded a box with a total surface (A), which is divided up into five 

surfaces (expand the surface tree by clicking on the "+" in front of A) FRONT, LEFT, TOP, RIGHT and 

BACK, each of which has been divided into a grid (4X4) of 16 segments over which sound intensity 

measurements have been taken.

For information on how to rename or add comments to a Noise Explorer project, please refer to Section 3.

Clicking on any of the measurement files hanging below the Measurements folder in the directory tree, 

with the right-hand mouse button, opens a pop-up. In the demonstration software, only some of these 

options are active.



Selecting the Properties option opens a three-page dialogue. On the General information page, 

background information on the measurement, along with comments and keywords can be added to the 

measurement file. The other two pages contain hardware details and settings.

Selecting specific data

The screen display that appears after double clicking on Demodata.stp consists of three separate views: 

Surface View, Text View, and Spectrum View. The views can be enlarged or shrunk by dragging their 

boundaries. The views can also be toggled on/off via View in the Windows toolbar at the top of the screen.



The three views are inter-related. The information displayed in the Spectrum View and the Text View 

relates to the measurement highlighted in the Surface View.

Let us now look at the three views individually. 

Surface View
In the surface view, the cursor takes the form of a red box. The cursor can be moved by the mouse over 

any of the measurement surfaces (in this case, only one). The figures displayed within the box are 

averages or in some cases summations for the complete surface.

Clicking on A in the project tree shows all the surfaces on the total box, and clicking on FRONT shows all 

the individual measurements, for the given surface, in grid format, with each individual measurement 

position occupying a segment within this grid. As above the cursor is a red box, which is used to highlight 

individual measurement positions. The information displayed in the segment can be selected in the 

Surface Properties pop-up menu, which can be opened two ways. One way is to double click with the 

left-hand mouse button, the other method involves opening it via the pop-up menu that appears when you 

click the right-hand mouse button.

Highlighting the Properties option opens a two-page Surface properties property sheet. Page one 

(Axis) allows you to choose the number of measurements (segments) to be viewed in the Surface View 



window at any one time. Page two (Legend), determines what parameters, derived quantities, and 

measurement information are displayed in the window. A maximum of four parameters can be displayed 

at any one time.

To change the parameters displayed, first highlight the one you wish to remove, this will activate the 

removal arrow. Click on this arrow and the highlighted parameter will be removed from the displayed 

parameters, and at the same time the add arrow will be activated, as there will now be less than four 

parameters to be displayed. You can then add a parameter by highlighting it in the left-hand column, and 

clicking on the add arrow.

Among the parameters you have to choose from, some have (Cursor) written after them. This will be 

explained in the next section. Should you choose a frequency dependent parameter, such as Intensity 

Lin, the middle column of the dialogue will give you a choice of frequencies for which the parameter value 

can be displayed. The various displayed properties shown, can be switched on or off via the bar at the 

bottom of the view.

Other items that appear in the menu - when you use the right-hand mouse button are:

Zoom Options

The contents of an individual segment are displayed according to the size of the segment. If the segment 

is too small, then the contents are shown as coloured dots in the corners. If you zoom in, the contents 

change to figures and text, as the segment becomes larger. 

Surface toggling

Sound intensity measurements are always taken over a surface or several surfaces. You can switch 

between the individual measurements and the (parent) surface they belong to using Surface Up/Down.

Export options

These allow you to export measurement information 

1.  in tab separated ASCII or *.xls format to a spreadsheet (see export to spreadsheet under 



spectrum view), 

2.  to surface mapping software such as Noise Source Identification Software Type 7752 using 

UFF-files or such as Golden software Surfer (Internet address: www.goldensoftware.com) using 

XLS-files, 

3.  or to UFF-files containing the total job. 

Export to Noise Source Identification Software Type 7752 can also be done by pressing the Map 

Surface button in the toolbar:

This will launch the Noise Source Identification software with the data from the current surface together 

with the dimensions of the surface. The UFF Spectrum parameter on the Surface Properties Legend 

determines which of the two measured spectra (Intensity or Pressure for Sound Power measurements) to 

export.

The mapping with the Type 7752 software of the five surfaces will look like:



Note: 7752 will automatically create a box (as above), if the box has the default surface names FRONT, 

LEFT, TOP, RIGHT and BACK and the surfaces are exported in this sequence.

Properties

If a reading appears wrong, it can be excluded by using the left-hand mouse button to highlight the box 

(click and drag). The menu that then appears gives you Zoom Range and Exclude Segments, the 

option of excluding the reading. Highlight a segment and drag until several segments are highlighted, and 

then use the Zoom Range option. The view will adjust to display the highlighted segments as large as 

possible within the view. If a segment or number of segments are excluded or re-included then all of the 

related parameters are recalculated based on the new situation.

Spectrum View
A 1/3 or 1/1- octave spectrum is shown for the measurement within the red box cursor, in the surface 

view. At the top of the Spectrum View is a display bar, which contains coloured blocks above the 

frequency bands that have been excluded, other blocks above where the dynamic capability has failed, 

etc. The information is displayed in the Status Codes as well.

Definitions of the failure modes/status codes can be found in the technical documentation for the 2260 

sound intensity software BZ7205

The default colour for the frequency bands is brown. Frequency bands that have, however, negative 

intensity or pressure values are displayed in blue.

The cursor, in the spectrum view, is a red line that appears when you click with the left-hand mouse 

button on a frequency band. At the bottom of the screen there is a read-out, which displays the frequency 

that the cursor is on, and the values of the selected display parameters, at that frequency, e.g. Intensity, A 

weighted or linear, Pressure and p-I index.

As mentioned above, should any of the parameters chosen for display in Surface View have (Cursor) 

after them, moving the cursor across different frequencies, will cause these parameters to be updated in 

the surface view to the value for the frequency under the cursor.

On the display line at the bottom of the view are the display parameter toggles. You can switch the 

various display parameters on/off here.

Clicking the right-hand mouse button on the spectrum graph opens a pop-up menu. The menu contains 

Zoom options, Export to Spreadsheet..., and Properties. The Spectrum Properties pop-up menu can 



also be opened, by double clicking with the left-hand mouse button. As with the Surface Properties 

pop-up menu, the Spectrum Properties pop-up menu has two pages. Page one (Axis) allows you to set 

the amplitude display range for the spectrum. Page two (Legend), lets you set the display parameters.

Export to Spreadsheet allows you to export the information for one measurement directly to an Excel 

spreadsheet. All of the frequency band readings, shown parameters and Status Codes information, for 

that particular measurement, are shown. Should one of these parameters contain direction information 

(+/-), it will be displayed in two columns. In addition to this information, other information such as date and 

time of measurement, software used, and relevant hardware information is also displayed in the 

spreadsheet.

Clicking with the left-hand mouse button and dragging highlights the frequency bands over which you 

have dragged. A pop-up then appears giving you the options of excluding or re-including the highlighted 

bands or zooming in on them in the same way as the Zoom Range function in the Surface View. 

Excluded or re-included frequency bands are excluded or re-included across all of the measurements, 

and this causes the whole measurement to be recalculated, based on the new situation.

Text view
This view allows you to display information about any individual measurement chosen in the surface view. 

The right-hand mouse button opens a menu, within this view, with an Export to spreadsheet... option, 

and a Properties option. The Export to Spreadsheet option is similar to the one available in the Spectrum 

View. All information displayed in the Text View is displayed in the spreadsheet, along with the set-up and 

hardware profile information given in the Spectrum View Export to Spreadsheet option.

The Properties option opens the Text Properties pop-up menu box. Here, you can add or remove 

parameters from the display. Every single piece of information for a given measurement can be displayed 

in this view.

.......................................................



End of Tutorial


